Leaving the Jobsite
Final MediaMatrix® Settings

OK.....so you've installed your first MediaMatrix® system. You have successfully
designed a really cool view file with all kinds of unique signal processing and
routing. The user interface screens are filled with easy-to-use graphics, and the
end user can operate the system without screwing it up.

Now you are ready for the final step......leaving the jobsite. To make sure that you
won’t be “nickel and dime’d” to death with service calls, let's go through some basic
essentials to “finalize” the system.

P rior to leaving the jobsite, you should have several goals in mind. A primary goal
should be that the customer will have no further need to call you in the immedi-
ate future. Or, if he does call, you have all the necessary backup files to restore the

system when someone accidentally hits “format c:\”

What you do at this time will depend upon the customer requirements (requests).
A typical scenario could be:

When the MediaMatrix is powered up in the morning, it automatically enters
Windows, automatically finds the audio view file (.pav), loads this file and
compiles it. The next decision is whether the system then goes to a Default
Preset (low level, morning music) or begins where you left off yesterday (very late
last night!) You must also decide at what Security Level it comes up in, whether
it bypasses the Program Manager or not, whether it starts PASHA™, and finally,
what control screen it comes up in.

To accomplish this, you need to “finalize” the MediaMatrix® system by properly
setting up this screen (which can be found under the Tools menu) and the
following areas:

Startup Options Ed |
System Startup Method Startup Privilege
“ Manual Startup Designer j
 Auto Start on Windows Boot Mo Access
 Startup As Program Manager Operator
Startup Yiew Load

< Start With Empty View
» Restore Yiews Loaded on Last Shutdown
» Load thiz view file__.

 Load and Compile thiz view file._. Browse
 Load and Activate thiz view file._ —

||::\.PEMEYWlEwSleﬁHLAMD_PAv |

1].4 Cancel | Help |
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Assumptions

MediaMatrix

he information contained in this paper is based on the assumption that a few
basics are included in your system. We have tried to keep this as simple as
possible, while covering the most common elements of system design. All of the
information presented applies to MediaMatrix systems using Windows 3.11 and
MWare™ V2.0 or higher (actually all MWare versions—just some of the screens
are different!)

We will assume that your system includes at least 2 global Presets, one of them
being the Default Preset . We will also assume that there are external controls,
such as a master volume, and switches to call up Presets or router controls.
Finally, we will assume that there are at least 2 levels of security in use, one

for you, and one for the user/operator. At this point in the job, the following

items should be confirmed:

* All of your connections, wire dress-off, etc. are complete.

* All of the audio connections are correct. Take time to ensure that polarity is
observed and any unbalanced signals are correctly wired.

(Low (-) jumpered to ground)

* Be sure that all of your Break-Out-Box (BoB ) cables are firmly seated in the
connectors and that they are screwed in and secure.

» Check the BoB cable dress-off to ensure that there are no radical bends or kinks
in the cable, and that you can easily identify which BoB port (DB-9 connectors
at rear of MM frame) connects to which BoB. Use labels!

» Double check the connections from the mouse and the keyboard.

Use the rear panel connections if you can.

» Verify that the monitor connector is screwed in firmly.

» Make sure that there is no disk left in the floppy drive.

» Make sure all the fans in the frame are unobstructed. Ensure good air flow
around and through the BoBs (one rack space between units is recommended).

O ne of the most common problems with installed sound is retaining the correct
adjustment of the tuned system. How many times have you painstakingly
aligned loudspeakers, performed hours of equalization (EQ), only to have your
masterpiece completely ruined by a well-meaning user? And then when the system
doesn’t sound right, it's your fault. One of the best things about MediaMatrix is that
this problem can be minimized or eliminated! With the extensive graphics capability
and multilevel security, any user interface can easily be created. In this section

we will discuss how to set up security levels, and determine the start-up method.



Security
Levels

M ediaMatrix has four levels of security, and an almost unlimited number of
available users. Here we want to make sure that the security and start-up
settings are correct.

The first step is to identify the users of the system. As we stated earlier,
our example will include two users. You, the “Designer ”, and the end user,
the “Operator ”.

Under the “User” menu, select “Edit User List” . The Account Administration
Dialog Box appears.

Account Adminiztration |
|gemge - Dezigner | .
Hew__.
Account Properties Ii
Delete...
Hame |geurge |
Pazzword |l:||:n:|a | Edit
Prvilege |pesigner j
Mo Access Help
Operator —
MNew passy
1] 4

The first thing we want to do is define you, the “Designer ”. Push the “New” button,
and find the above Account Properties Prompt. The prompt will be for your name
only. The password is a random four (4) character alpha default (that you must
accept!) Write it down before you do anything else. All of the entries in this box
are case-sensitive, so record everything exactly. Be sure to select “Designer”
under the “Privilege” pull down menu, and then hit “OK” .

NOTE: You will want to enter your Designer level access and verify that the
password allows you entry into the system before going any further!

Repeat this entire process for each user in the system. In our example, the next

user would be the “Operator” . Remember, the default passwords must be ac-
cepted first.
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ST=Tell[ai)YA After you have set up each user, their default passwords and security level, you
W=W= [ can proceed with personalized passwords if you desire. Each user will now have to
foleja1 |0g on to access their password option.

Select the “User” pull down menu again, Lag On E|
apd select “Log On” . The Log On Dialog Box Name [goorge |
will appear.
Pazsword [==== |
Select this button ————p [V Change Password
to personalize
your password 1] 4 Cancel Help |

Enter your user name and default password. (The one you wrote down). If you
want to change the password from the default characters to your own personalized
password, put a check mark in the “Change Password” box before selecting
“OK” . The system will then prompt you for your new password, and ask you to
confirm it. Remember, all of this is case-sensitive, so write everything down.

Change Paszword

Enter New Password | | Enter your new case-sensitive
| password here.

Bepeat Hew Paszzword |

(1].4 Cancel Help |

Now that your user list is set up, it is time to determine what features your end user,
the “Operator”, will have access to. Under the “User” pull down menu, select
“Edit Operator Privileges” . This brings up the Operator Privileges Dialog Box.
These settings are “global” and affect all Operator level users.

Operator Privileges |

Operators are allowed to...

¥| Accezs control mode.

__| Cloze the application.

__| Cloze or switch the running view S-e/eCt each feature you would

; like for the “Operator” access
_| Run hardware diagnostics. level. NOTE: This is “global”
_| Interact with the terminal window. for all Operators.

__| Change terminal settings.

_ | Access the online help system.

1] Cancel

Place a check mark in the box for each feature you want to activate. At a minimum,

m the Operator should have access to Control Mode. This will allow the user to turn
knobs, push switches, move faders, etc. The other features will not be available to
the user unless a check mark is active for each feature you desire. Please use the
on-line Help menu within MediaMatrix for more detailed information.
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Besides the Operator Privilege restriction, the Operator Mode has other inherent
restrictions. For example, the Operator cannot access Edit Mode. This will prevent
the user from editing properties, adding or deleting devices or opening edit-level
protected blocks. Make sure that the security scheme you desire for your client is
the right one. Don't give a user something that will get them into trouble, but don’t
prevent knowledgeable staff from accessing important devices or controls. A good
balance of end user access will prevent many phone calls to your office on Friday
afternoon asking you to come and tweak the high end on their monitor rig.

Once all of this is done, make a written note of all passwords and the corresponding
user name. Remember, the Passwords are case-sensitive, so document them too.
It is also a good idea to include this information in your backup files. Make a .txt file
using Notepad, and document names, passwords and access levels for each user.

NOTE: If you have assigned password protection to a “block” device such as
your supersecret custom overhead ceiling speaker processing device, you
will be asked to enter that password every time you click on it to open it up.
However, if assign the same password to your Designer level system access,
you will have automatic access to all blocks protected with that same
password!

Start-up
Settings

he final step in proper security is to determine the start-up privilege. Again, _

use common sense and good balance. Normally, a low user privilege is set
for start-up, requiring advanced users to “Log On”. To set the Start-up Privilege,
Select the “Tools” pull down menu, and select “Startup Options” . Under
“Startup Privilege” in the Startup Options Dialog Box, select the security level
you desire. When you boot the system, this is the level that can be accessed
after the system is compiled and audio is running.

CAUTION: Do not select anything other than Designer Level if you have not
established a Designer Level user and correct access password.

User Window Help

Giroup Security Start-up Level is
Urigraup assigned here.
Eroperties,.. Sl+Enter
yindoy Properties,. ’_> glarupliptions

System Startup Method Startup Privilege W
[retine Dewvize,.. = Designer r
Flemovs Device:. This 3 Srertup s Progmam Haneger
Fefiesty Mevice Menu OPG.I’IS Startap View Load
Sound Engite Optioks... A// _l'hIS © Start With Empty View
Iser Interface Optionz. . window ; f::;ol':i: — t‘,’: '_1_9'1 on Last Shuldown
Starip Opicrs. | s e |
Diagnostics... m
Optional Features... | |
it 0K | Cancel | Help |
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Start-up
Settings

MediaMatrix

If you desire the “No Access” level upon start-up, it is our recommendation that
signal presence LEDs or meters be placed on the parent start-up screen. This will
allow the person who starts the system to see at a glance if there is audio present
at the outputs. We also recommend that Overload LEDs be visible so that if any
abnormally high audio output levels are present, the user can see them easily prior
to amplifier turn-on.

When Windows is loaded, it normally stops at Program Manager. Because this
is an audio system, not an office desktop system, you may want to bypass
Program Manager .

Normally, the MediaMatrix system is configured so that start-up is transparent to the
user. In other words, the user shouldn’t have to boot Windows, start MediaMatrix,
load the correct view file and compile the audio. This can be accomplished by
choosing “Auto Start on Windows Boot ”. To fully accomplish this task
automatically, the C:\autoexec.bat file must contain the word “win” in the

last line.

To load MediaMatrix automatically, bypassing Program Manager, select “Startup as
Program Manager ” under the “System Startup Method ”. The other options are:
“Manual Startup " to start MediaMatrix from the Windows Program Manager, and
“Auto Start on Windows Boot ”, which will automatically load MediaMatrix, but
will retain the Program Manager shell.

Startup Options |
System Startup Method Startup Privilege
»» Manual Startup Mo Access j

 Auto Start on Windows Boot | eSS
< Startup As Program Manager

Operator
Supervisor
Designer

Startup ¥iew Load

 Start With Empty Yiew
 Bestore ¥iews Loaded on Last Shutdown
= Load thiz view file...

< Load and Compile this view file._. Browse
7 Load and Activate this view file._ =

|E:\PEA\JEYWIEWS\.HIEHLAND.PMF |

1] 4 Cancel | Help |

Under “Startup View Load ", we can determine which, if any, view file starts up,
and if it is compiled. Again, for a transparent user start-up, we want an automatic
action. So, select “Load and Compile this view file ....” In the Dialog Box below,
type or browse, the path (location) of the project view file.



Start-up
Settings

Open Yiew |
File Hame: Directories:
|highland.pav | c:hpeavepiviews
firealrm.pavy - et -
gapsense.pay 5 peavey

graftzt_pav - By views

: ) L1 opryland
home_pav L1 pashaini
hotel. pa¥ ] tutorial -
hothous5. pay -
Lizt Files of Typpe: Dnves:
Yiew Files [*.pav] j I =1 o j
0K Cancel |

Click on the “Browse " button to open this window to find a particular file. Double
click on the file you want to store the location to the start-up path.

It is important to note that when MediaMatrix is set to start up as Program Manager,
other applications, such as PASHA™, or third party software, will not be accessible.
This includes applications that reside in the Windows “Startup ” group. This
problem has prevented users of PASHA from configuring the system in this
manner, because there was no method for automatically launching PASHA.

You can configure MediaMatrix to automatically launch other programs when

it is started by making the following modification to the pa.ini file (shown on next
file). The pa.ini file resides in the Windows directory and can be edited with
Windows Notepad. Add a section titled [ProgramLaunch] to the pa.ini file. In this
section, add an entry for each program you want to run. The entry should contain
the complete path and any optional command line arguments that you want to pass
to the program.
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SYecigsillel  You can have up to 9 entries as shown in this example:

Settings JpEY
cont. Created=04/28/97

[Pavcon]

SecurityFileCreated=True
LastViewDirectory=C:\PEAVEY\PROJECTS
StatBoxIsMore=True

MaximizeView=True
FramePosition=-32768 0 -32768 0
MaximizeFrame=True

TerminalPosition= 0 0 804 460
TimeStamp=True

AutoWrap=False

AutoLoadl=
LastFilel=c:\peavey\projects\newseum.pav
LoadPresetAfterCompile=False
SetValuesAfterCompile=True
PalettePosition=604 432 112 336
AutolLoad2=
LastFile2=c:\peavey\projects\gold.pav
LastBitMapDirectory=C:\PEAVEY\BMPS
LastFile3=c:\peavey\projects\klay.pav
LastFiled=c:\peavey\projects\gedemer.pav
LastFile5=c:\peavey\projects\chrch108.pav
ZoomPercent=100
LastFile6=c:\peavey\projects\ldsmeet.pav

[Program Launch]
RUN1=C:\PEAVEY\PASHA.EXE /COM1 <
RUN2=C:\WINDOWS\NOTEPAD.EXE «—

Add this section to the pa.ini file.

L Add one line for each
[Padpu] application that you want

SampleRate=44100 ;
It (maximum 9).
delay_compensate=FALSE fo start (ma um 9)

ext_sync=FALSE

Now, with all of that done, the system will start up, load Windows, load MediaMatrix,
start PASHA, load Notepad, and load your system view file and compile the audio.
Voila! Audio running, customer happy, no service calls.

resets and SubPresets are very powerful tools. However, they can be
double-edged swords if you are not aware of what they do and don't do.

It is important to ensure that all of the system’s controls are properly stored within
the Presets, and that the Presets themselves are not resetting each other. Very
often, inexperienced (meaning they haven't been bitten by this yet!) designers will
get themselves into a situation where they are “chasing their tails” in an endless
loop of “Preset-resets”. This is especially true when there are a lot of “nested”
Presets and SubPresets hidden away in blocks where you can easily forget about
them.

It is important to understand what exactly a Preset stores — anything inside of
your view file that can be gestured is stored as part of your Preset . Besides
device controls, this also includes BoB control port settings that reside within
externally controllable [E] devices, and the settings within the BoB External

’H Control block. Those little white boxes with values in them are technically controls,
and are therefore stored in the Preset file. These must be set correctly before you
save the Preset. It is equally important that all those externally controlled devices

- ] be calibrated (set min/set max) prior to saving!
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Load
Default Preset

| nonexistent

Save Yes

| s | <«——— External Control
BoB [o ] |BoBctibum [T ] Setting boxes.
Date and Time

For example....let's say that you have an external potentiometer wired to a Level [E]
control. That control has a BoB number assign box and a BoB port assign box
within its block. If you forgot to assign values to these, they will be at their default,
which is off. If there is a Preset already saved within the view, these off values are
a part of it. So, no matter how many times you reset the port values.....to make your
external volume control work.....the Preset will reset them off every time it is loaded!
If you have a lot of [E] devices, and a lot of Presets and SubPresets, this can get
real messy, real fast.

NOTE: Please refer to the paper “External Control via the Breakout Box” for
more detailed information.

The same logic applies to the Preset’s own external control assignments. The
Preset or SubPreset itself can be assigned to an external control such as a switch,
to allow simple recall of system settings.

The bottom line here is...... Make sure that all of your BoB port and control
assignments are set correctly  before you start saving Presets!

You may now want to set your system start-up to load the Default Preset . This can
be defined as the system wake-up state after being powered up, either the first thing
in the morning or possibly after a power outage. This becomes a predefined state,
regardless of where the system was last set at the end of yesterday’s sessions.

In the “Sound Engine Options” Dialog Box, under “Control Settings in Effect
After Compile” , select “Load Default Preset” . This will enable the default Preset
every time the system is booted.

Sound Engine Options
Control Settings in Effect After Compile
“ llse Settings Saved With View < The aUdIO Staft-Up
 Load Default Preset . .
State is determined
Sample Bate Hardware Base Address by thIS Settlng
32000 =] | [peooo E
44100 Dip Switches: OK
43000
| Enabled 1001508

Cancel
External Sync

__ | Enabled Help
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If the “Use Settings Saved With View” option is selected, the system controls will

load at their last saved state. This “last saved state” includes all settings at the

time the file was last saved. It is possible that this state is NOT what you want

for normal audio performance. For example, if you set everything up, and saved

those settings in a Preset, and then, after more tweaking, you saved the file, it

: would be this “tweaked” state that would be the last audio setting. So be very
2R careful about what you select, and which Preset, or “saved state”, you want

STETlefSl  your default audio to be.

F inally....when all things are final, check the following to maximize
system performance:

» Delete all unused BoB External Control Blocks.
(speeds system up as all these controls ports have to be continuously polled)

* Setthe level of Undo to a lower level, such as “3". This can be found in the

“Tools” pull down menu, under “User Interface Options” Dialog Box.
(reserves RAM space as each Undo screen must be remembered)

» Verify Sample Rate speed and hardware settings.

Note: Delay Compensation must be used for Mix-Minus and true Stereo systems.

User Interface Options [ %]
Default Background Color  Grid
— x ¥
Snap
Levels of Undo . EI EI
B

Undo Levels ————» [0 ] | | showana

Child Window Behavior

/| Always overlap parent

v/| Automatically close child windows

Cancel
16 Color Display

uil

‘ _| Controls are black on my 16 color display Help
DPU cards set at factory
to D8000. (do not change!)
\Eonlml Settings in Effect After Compile
@* Settings Saved With View
> Load ault Preset
Sample Rate mUSt Sample Rate Hardware Base Address
N\,
match BoB type. _>\ -] *{psooo H
32000 - )
] l Dip Switches:
Delay Compensation must be ——» = Enabrea 100100 -
used for Mix-Minus and External Sync 4|
true Stereo systems. \ L) e \ Help |

ecause this is a computer-based product, there are several files that should
be copied to floppy disks (for backup!) before you walk away. We recommend
that two (2) copies of the following files be retained for each project. Keep one in
your office and leave the other at the jobsite. Leave it with the owner, or better
m yet....hide it in the back of the rack (not near any power supplies, however!) Put
the disks in a sturdy plastic storage box and mount it inside the rack. That way, if
you ever have to return for a service call, all of the system files will be there just
as you left them.
MediaMatrix 10



NOTE: We highly recommend that you DO NOT alter ANY of these files
without factory assistance. The system is set up with optimum settings
when it leaves the factory. ANY changes to system-sensitive files or
hardware settings could result in unsatisfactory performance.

config.sys (C:\config.sys)

This is the file which configures your system memory. Remember, DOS machines
can only access 640K of memory at a time. The config.sys file determines which
devices are loaded high in memory and also determines memory locations for
those devices as well as any TSR (terminate and stay resident) applications

that you may have.

autoexec.bat (C:\autoexec.bat)

This is a crucial file. It determines the DOS start-up and runs the Windows
executable. Among other things, it contains the path of start-up files that
need to load at power-up.

win.ini (C:\WINDOWS\win.ini)

This initialization file contains all of your basic Windows settings. (Things like
your desktop settings, mouse type, fonts, etc.) It also includes the locations,
or paths, of the Windows applications installed on your system.

system.ini (C:\WINDOWS\system.ini)

Among other things, this file stores the location of Windows device drivers
and enhanced mode settings.

pa.ini (C:\WINDOWS\pa.ini)

This is the MediaMatrix initialization file that stores user settings, sound engine
options, security codes and more. Do not under any condition delete or
lose this file; doing so will halt all further use of your DSP_sound engine.

pasha.ini (C:\PEAVEY\pasha.ini)

If you are running PASHA, this file is crucial, unless you really like rewriting
control code.

Other files (C:\PEAVEY\VIEWS\xx.00p)

Finally, it is important to copy all of your view files, backups and Preset files.
These normally reside in your “views” (C:\peavey\views....) directory. A list of
these files would be as follows:

(filename).pav files your view files (the audio system!)
(filename).01p files your Preset files (.01p thru .99p)
(filename).01s files your SubPreset files (.01s thru .99s)
(filename).bmp files your bitmap files (any custom bitmaps)
(filename).bak files your view backup files (if you desire)

11
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Other files (C:\peavey\views\xx.00p) (cont.)

Also, if you created any custom devices via the “Define Device” option, include
these files as well (.dvc). All of these should be included in your backup copies.

Also, to assist us in troubleshooting, it would be very helpful if you would send us a
copy of all the above files. If you ever have a problem, we can use this information
to get you up and running again with minimal downtime. Send your disks to:

Peavey Electronics Corporation « MediaMatrix Support Group
711 A Street » Meridian, MS « 39301

Final
Settings

hat'’s it, you're done. The system should start up, load your view file, compile
and start the audio to the settings you worked so hard on. The performance
and operation of the MediaMatrix system should be transparent to the end user.

For more information and helpful hints, please refer to the following publications
available from Peavey:

« MediaMatrix MWare™ Manual

» MediaMatrix MWare V2.1 Read.me File

* MediaMatrix MWare V2.1 Help File

» MediaMatrix Series Technical Manual

» External Control via the Breakout Box White Paper
« AmpWare™ White Paper

» Our Website—http://www.peavey.com

Finally, if you need further information, or just need help, don't hesitate to call us.
You can reach us during regular business hours at (601) 483-5376.

You can also get 24-hour emergency help on our SkyPager at (800) 759-7243,
PIN# 113-4326.

Please reserve this for true MediaMatrix emergencies or weekend use

The address for correspondence is:

Peavey Electronics Corporation « MediaMatrix Support Group
711 A Street » Meridian, MS « 39301

On-line help is available via:

* http://www.peavey.com

» Gwdouglas@aol.com - view files or text files, bitmaps, etc.
’” » ahendrix@peavey.e-mail.com - text only files
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